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Preface

This guide provides information about how to install Oracle Health Sciences Clinical 
Development Analytics Standard Configuration (OHSCDA). 

This preface contains the following topics:

■ Audience on page v

■ Documentation Accessibility on page v

■ Finding Certification Information on page vi

■ Finding Information and Patches on My Oracle Support on page vi

■ Finding Documentation on Oracle Technology Network on page viii

■ Related Documents on page viii

■ Conventions on page ix

Audience
This installation guide is intended for users who are responsible for installing Oracle 
Health Sciences Clinical Development Analytics Standard Configuration. You should 
be familiar with:

■ Oracle Database

■ Oracle Business Intelligence Enterprise Edition (OBIEE) application

■ Oracle Business Intelligence Data Warehouse Administration Console (DAC) 
application

■ Informatica PowerCenter application

■ Oracle Healthcare Master Person Index (OHMPI) application

OHMPI is required only if you want to use deduplication.

Documentation Accessibility
For information about Oracle's commitment to accessibility, visit the Oracle 
Accessibility Program website at 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.

Access to Oracle Support
Oracle customers have access to electronic support through My Oracle Support. For 
information, visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or 
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visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing 
impaired.

Finding Certification Information
Certifications provide access to product certification information for Oracle and third 
party products. A product is certified for support on a specific release of an operating 
system on a particular hardware platform, for example, Oracle Database 10g Release 2 
(10.2.0.1.0) on Sun Solaris 10 (SPARC). To find certification information: 

1. Sign in to My Oracle Support at http://support.oracle.com.

2. Click the Certifications tab. The Certifications page opens and displays the Find 
Certifications region.

3. In Select Product, enter Oracle Health Sciences Clinical Development 
Analytics.

4. Click the Go to Certifications icon.

The right pane displays the certification information.

5. Select a certification to view the certification details.

Finding Information and Patches on My Oracle Support
Your source for the latest information about Oracle Health Sciences Clinical 
Development Analytics Standard Configuration is Oracle Support's self-service Web 
site, My Oracle Support (formerly MetaLink). 

Before you install and use an Oracle software release, always visit the My Oracle 
Support Web site for the latest information, including alerts, release notes, 
documentation, and patches.

Creating a My Oracle Support Account
You must register at My Oracle Support to obtain a user name and password account 
before you can enter the Web site.

To register for My Oracle Support:

1. Open a Web browser to http://support.oracle.com.

2. Click the Register here link to create a My Oracle Support account. The 
registration page opens. 

3. Follow the instructions on the registration page.

Signing In to My Oracle Support
To sign in to My Oracle Support:

1. Open a Web browser to http://support.oracle.com.

2. Click Sign In.

3. Enter your user name and password.

4. Click Go to open the My Oracle Support home page.

Searching for Knowledge Articles by ID Number or Text String
The fastest way to search for product documentation, release notes, and white papers 
is by the article ID number.
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To search by the article ID number:

1. Sign in to My Oracle Support at http://support.oracle.com.

2. Locate the Search box in the upper right corner of the My Oracle Support page.

3. Click the sources icon to the left of the search box, and then select Article ID from 
the list.

4. Enter the article ID number in the text box.

5. Click the magnifying glass icon to the right of the search box (or press the Enter 
key) to execute your search.

The Knowledge page displays the results of your search. If the article is found, 
click the link to view the abstract, text, attachments, and related products.

In addition to searching by article ID, you can use the following My Oracle Support 
tools to browse and search the knowledge base:

■ Product Focus — On the Knowledge page, you can drill into a product area 
through the Browse Knowledge menu on the left side of the page. In the Browse 
any Product, By Name field, type in part of the product name, and then select the 
product from the list. Alternatively, you can click the arrow icon to view the 
complete list of Oracle products and then select your product. This option lets you 
focus your browsing and searching on a specific product or set of products.

■ Refine Search — Once you have results from a search, use the Refine Search 
options on the right side of the Knowledge page to narrow your search and make 
the results more relevant.

■ Advanced Search — You can specify one or more search criteria, such as source, 
exact phrase, and related product, to find knowledge articles and documentation.

Finding Patches on My Oracle Support
Be sure to check My Oracle Support for the latest patches, if any, for your product. You 
can search for patches by patch ID or number, or by product or family.

To locate and download a patch:

1. Sign in to My Oracle Support at http://support.oracle.com.

2. Click the Patches & Updates tab. 

The Patches & Updates page opens and displays the Patch Search region. You have 
the following options:

■ In the Patch ID or Number is field, enter the primary bug number of the patch 
you want. This option is useful if you already know the patch number.

■ To find a patch by product name, release, and platform, click the Product or 
Family link to enter one or more search criteria.

3. Click Search to execute your query. The Patch Search Results page opens.

4. Click the patch ID number. The system displays details about the patch. In 
addition, you can view the Read Me file before downloading the patch.

5. Click Download. Follow the instructions on the screen to download, save, and 
install the patch files.
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Finding Documentation on Oracle Technology Network
The Oracle Technology Network Web site contains links to all Oracle user and 
reference documentation. To find user documentation for Oracle products:

1. Go to the Oracle Technology Network at

http://www.oracle.com/technetwork/index.html and log in.

2. Mouse over the Support tab, then click the Documentation hyperlink.

Alternatively, go to Oracle Documentation page at

http://www.oracle.com/technology/documentation/index.html

3. Navigate to the product you need and click the link.

For example, scroll down to the Applications section and click Oracle Health 
Sciences Applications.

4. Click the link for the documentation you need.

Related Documents
For more information, see the following documents in the Oracle Business Intelligence 
Data Warehouse Administration Console 11.1.1.6.4 documentation set, the Oracle 
Business Intelligence Enterprise Edition Release 11.1.1.6.4 documentation set, and 
Oracle Healthcare Master Person Index Release 1.1 documentation set.

Oracle Business Intelligence Data Warehouse Administration Console (DAC) 
Documentation
The Oracle Business Intelligence Data Warehouse Administration Console (DAC) 
documentation set includes: 

■ Oracle Business Intelligence Data Warehouse Administration Console User's Guide 

■ Oracle Business Intelligence Data Warehouse Administration Console Installation, 
Configuration, and Upgrade Guide 

Oracle Business Intelligence Enterprise Edition (OBIEE) Documentation
The Oracle Business Intelligence Suite Enterprise Edition Online Documentation Library 
documentation set includes: 

■ Oracle® Fusion Middleware User's Guide for Oracle Business Intelligence Enterprise 
Edition 11g Release 1 (11.1.1) 

■ Oracle® Fusion Middleware Metadata Repository Builder's Guide for Oracle Business 
Intelligence Enterprise Edition 11g Release 1 (11.1.1)

■ Oracle® Fusion Middleware System Administrator's Guide for Oracle Business 
Intelligence Enterprise Edition 11g Release 1 (11.1.1)

■ Oracle® Fusion Middleware Scheduling Jobs Guide for Oracle Business Intelligence 
Enterprise Edition 11g Release 1 (11.1.1) 

■ Oracle® Fusion Middleware Security Guide for Oracle Business Intelligence Enterprise 
Edition 11g Release 1 (11.1.1) 

■ Oracle® Fusion Middleware Developer's Guide for Oracle Business Intelligence 
Enterprise Edition 11g Release 1 (11.1.1) 

■ Oracle® Fusion Middleware Integrator's Guide for Oracle Business Intelligence 
Enterprise Edition 11g Release 1 (11.1.1) 
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Oracle Healthcare Master Person Index (OHMPI) Documentation
For more information and instructions for implementing and using a master index 
application, see the following documents in the Oracle Healthcare Master Person 
Index Release 1.1 documentation set:

■ Oracle Healthcare Master Person Index Installation Guide

■ Oracle Healthcare Master Person Index Release Notes

■ Oracle Healthcare Master Person Index User’s Guide

■ Oracle Healthcare Master Person Index Configuration Guide

■ Oracle Healthcare Master Person Index Configuration Reference

■ Oracle Healthcare Master Person Index Data Manager’s Guide

■ Oracle Healthcare Master Person Index Match Engine Reference

■ Oracle Healthcare Master Person Index Standardization Engine Reference 

■ Oracle Healthcare Master Person Index Analyzing and Cleansing Data User’s Guide 

■ Oracle Healthcare Master Person Index Loading the Initial Data Set User’s Guide 

■ Oracle Healthcare Master Person Index Command Line Reports and Database 
Maintenance User’s Guide 

■ Oracle Healthcare Master Person Index Working With IHE Profiles 

■ Oracle Healthcare Master Person Index WebLogic User’s Guide 

Conventions
The following text conventions are used in this document:

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated 
with an action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for 
which you supply particular values.

monospace Monospace type indicates commands within a paragraph, URLs, code 
in examples, text that appears on the screen, or text that you enter.
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1Before You Begin

This section presents an overview of the Oracle Health Sciences Clinical Development 
Analytics (OHSCDA) requirements. It also describes the tasks that you must complete 
before you can install the application.

This chapter includes the following section:

■ Technology Stack and System Requirements on page 1

■ General Security Principles on page 1

■ Security Guidelines for Oracle Business Intelligence Data Warehouse 
Administration Console on page 1

■ Security Guidelines for Oracle Healthcare Master Person Index on page 1

■ Security Guidelines for Oracle Business Intelligence Enterprise Edition on page 6

■ Installing the Prerequisite Software on page 7

1.1 Technology Stack and System Requirements
The requisite technology stack for OHSCDA configuration is provided in the media 
pack, with the exception of Informatica. It consists of the following products:

■ Oracle Database 11.2.0.3

■ Oracle WebLogic Server 10.3.5

■ Oracle Business Intelligence Enterprise Edition (OBIEE) 11.1.1.6 and patches 
14538078, 14538128, 14285344, 14538164, 14415773, 14405222, and 14409674.

■ Oracle Business Intelligence Data Warehouse Administration Console 10.1.3.4.1 
and patch 14306642.

■ Informatica PowerCenter 9.0.1 HotFix 2

Note: Informatica is not part of the media pack. You need to acquire 
its license separately.

All references to media pack server in this document refer to the 
computer onto which you download the media pack for Oracle Health 
Sciences Clinical Development Analytics (Standard Configuration).

Make sure that the domain information of the Informatica repository, 
where you plan to import OHSCDA related Informatica mappings, is 
added to domains.infa file of the Informatica client.
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■ Oracle Healthcare Master Person Index (OHMPI) 1.1.2 with patch 12735093 
(Optional)

Installation Considerations
■ Determine the computer on which you will install each component of OHSCDA 

(Standard Configuration).

■ You may select to install each product on a different server, if required. The 
OHSCDA (Standard Configuration) media pack server does not have to act as 
server for any of the products, though it may. You may consult Figure 1–1, and the 
documentation listed in Table 1–1 for information on installing each product.

■ Determine the databases you need to create.

■ You must create a database schema to serve as the warehouse for OHSCDA.

■ If you have already installed OHSCDA for Plus Configuration, you may not create 
the OHSCDA schema for Standard Configuration in the same database that has 
Oracle LSH; doing so would create a name collision.

■ It is a good practice to create the schema for the OHSCDA Standard Configuration 
warehouse in a new database.

■ You may select to create schemas for repositories for the other OHSCDA 
components in the same database that will be used for the OHSCDA warehouse. It 
minimizes the number of databases that you need to maintain for OHSCDA. 
However, if you will be using the component applications for purposes other than 
OHSCDA, Oracle recommends that you create their repositories in instances other 
than the one holding the OHSCDA warehouse.

■ If you plan to implement deduplication, you may create the schemas for the 
OHMPI Master Indexes either in the OHSCDA warehouse database, or in a 
separate database specific to OHMPI Master Indexes. If you are using OHMPI for 

Table 1–1  System Requirements References

Product Reference

Oracle Database 11.2.0.3 Database Installation Guide for <platform>

Oracle WebLogic Server 10.3.5 Oracle WebLogic Server Documentation Library

Oracle Business Intelligence Enterprise Edition (OBIEE) 
11.1.1.6 and patches 14538078, 14538128, 14285344, 
14538164, 14415773, 14405222, and 14409674.

System Requirements and Supported Platforms for Oracle Business 
Intelligence Suite Enterprise Edition

Oracle Business Intelligence Infrastructure Installation and Configuration 
Guide

Oracle Business Intelligence Data Warehouse 
Administration Console 10.1.3.4.1 and patch 14306642 

Oracle Business Intelligence Data Warehouse Administration Console 
Installation, Configuration, and Upgrade Guide

Data Warehouse Administration Console User's Guide

Informatica PowerCenter 9.0.1 HotFix 2 Informatica PowerCenter Installation Guide

Oracle Healthcare Master Person Index 1.1.2 patch 
12735093

Oracle Healthcare Master Person Index Documentation Library

Other Technology Stack Components My Oracle Support / Certifications

Note: It is important to get the technology stack products from the 
OHSCDA media pack because newer versions of the technology stack 
products may have become available but may not be compatible with 
OHSCDA.
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purposes in addition to OHSCDA, Oracle recommends that the Master Index 
schemas be created in a database specific to OHMPI.

■ OHMPI Projects need to be deployed on Oracle WebLogic Server. You may select 
to deploy the OHMPI projects on the same Oracle WebLogic Server used for 
OBIEE by creating a new WebLogic domain running on different port (which is 
not used by any other domains) or you may choose to deploy the projects on a 
different Oracle WebLogic Server instance.

Figure 1–1 Oracle Health Sciences Clinical Development Analytics Technology for 
Standard Configuration

For more information about certifications, refer to Finding Certification Information on 
page vi.

1.1.1 Supported Browsers
OHSCDA supports those Internet browsers supported by OBIEE. For a list of the 
browsers supported by OBIEE, refer to Oracle Fusion Middleware System Administrator's 
Guide for Oracle Business Intelligence Enterprise Edition

11g Release 1 (11.1.1). 

1.1.2 Source Systems
CDA is designed to extract data from the following two systems:

1. OC 4.5.0.23 or higher

2. SC 8.0.x or 8.1.1. 

1.2 General Security Principles
The following principles are fundamental to using any application securely.
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1.2.1 Keep Software Up To Date
One of the principles of good security practice is to keep all software versions and 
patches up to date.

1.2.2 Keep Up To Date on Latest Security Information Critical Patch Updates
Oracle continually improves its software and documentation. Critical Patch Updates 
are the primary means of releasing security fixes for Oracle products to customers 
with valid support contracts. They are released on the Tuesday closest to the 17th day 
of January, April, July and October. We highly recommend customers apply these 
patches as soon as they are released.

1.2.3 Configure Strong Passwords on the Database
Although the importance of passwords is well known, the following basic rule of 
security management is worth repeating:

Ensure all passwords are strong passwords.

You can strengthen passwords by creating and using password policies for your 
organization. For guidelines on securing passwords and for additional ways to protect 
passwords, refer to the Oracle® Database Security Guide specific to the database release 
you are using.

You should modify the following passwords to use your policy-compliant strings:

■ Passwords for the database default accounts, such as SYS and SYSTEM.

■ Passwords for the database application-specific schema accounts, such as RXI.

■ The password for the database listener. Oracle recommends that you do not 
configure a password for the database listener as that will enable remote 
administration. For more information, refer to Oracle® Database Net Services 
Reference 11g Release 2 (11.2)

1.2.4 Follow the Principle of Least Privilege
The principle of least privilege states that users should be given the least amount of 
privilege to perform their jobs. Overly ambitious granting of responsibilities, roles, 
grants — especially early on in an organization's life cycle when people are few and 
work needs to be done quickly — often leaves a system wide open for abuse. User 
privileges should be reviewed periodically to determine relevance to current job 
responsibilities.

1.2.5 Managing Default User Accounts
Lock and expire default user accounts.

1.2.6 Closing All Open Ports Not in Use
Keep only the minimum number of ports open. You should close all ports not in use.

1.2.7 Disabling the Telnet Service
Oracle Health Sciences Clinical Development Analytics Standard Configuration does 
not use the Telnet service.

Telnet listens on port 23 by default.
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If the Telnet service is available on any computer, Oracle recommends that you disable 
Telnet in favor of Secure Shell (SSH). Telnet, which sends clear-text passwords and 
user names through a log-in, is a security risk to your servers. Disabling Telnet 
tightens and protects your system security.

1.2.8 Disabling Other Unused Services
In addition to not using Telnet, the Oracle Health Sciences Clinical Development 
Analytics Standard Configuration does not use the following services or information 
for any functionality:

■ Simple Mail Transfer Protocol (SMTP): This protocol is an Internet standard for 
E-mail transmission across Internet Protocol (IP) networks.

■ Identification Protocol (identd): This protocol is generally used to identify the 
owner of a TCP connection on UNIX.

■ Simple Network Management Protocol (SNMP): This protocol is a method for 
managing and reporting information about different systems.

Restricting these services or information does not affect the use of Oracle Health 
Sciences Clinical Development Analytics Standard Configuration. If you are not using 
these services for other applications, Oracle recommends that you disable these 
services to minimize your security exposure. If you need SMTP, identd, or SNMP for 
other applications, be sure to upgrade to the latest version of the protocol to provide 
the most up-to-date security for your system.

1.2.9 Designing for Multiple Layers of Protection
When designing a secure deployment, design multiple layers of protection. If a hacker 
should gain access to one layer, such as the application server, that should not 
automatically give them easy access to other layers, such as the database server.

Providing multiple layers of protection may include:

■ Enable only those ports required for communication between different tiers, for 
example, only allowing communication to the database tier on the port used for 
SQL*NET communications (1521 by default).

■ Place firewalls between servers so that only expected traffic can move between 
servers.

1.2.10 Enabling SSL
Due to the complexity in setting up SSL it is not enabled by default during installation. 
Communications between the browser and the application servers should be restricted 
to SSL. See the Oracle WebLogic Server 11g guidelines for instructions on enabling 
SSL.

1.3 Security Guidelines for Oracle Business Intelligence Data Warehouse 
Administration Console 

While installing and configuring the DAC Server, follow the guidelines documented in 
Oracle Business Intelligence Data Warehouse Administration Console Installation, 
Configuration, and Upgrade Guide.

The OHSCDA DAC metadata consists of DAC Repository which must be deployed on 
the DAC Server.
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After deploying the DAC Repository, make sure all connection configurations are 
altered as described in the DAC Installation Guide to point to the customer database 
connection parameters.

The DAC Repository contains only metadata for OHSCDA Informatica ETLs. The 
metadata is used within the context of the DAC Server. Follow the security guidelines 
applicable to the DAC Server while importing the metadata.

1.4 Security Guidelines for Oracle Healthcare Master Person Index
While installing and configuring OHMPI, follow the guidelines documented in Oracle 
Healthcare Master Person Index Installation Guide.

OHSCDA need to store the OHMPI username and password that is needed to set 
Context and call the OHMPI EJB during incremental dedup ETL execution. This user 
name and password is encrypted and stored in secret store wallet files. Key 
management is built in using a Java program, eliminating the complex task of creating, 
managing, and securing information.

 Java program code in Informatica Java transformation is used to retrieve the 
password during incremental OHMPI program executions which are then used for 
setting context and executing the OHMPI EJB. These programs are executed with the 
privileges of Informatica OS user which works implicitly granting access to restricted 
folders and wallet files in them.

While importing and setting up OHSCDA's OHMPI projects, follow the guidelines 
documented in OHMPI documents.

The OHSCDA's OHMPI metadata consists of 15 OHMPI projects which are zipped 
into individual files. Ensure that only an Administrator is given access to these files.

After importing the projects, make sure that the data source connection, JMS Servers, 
and JMS Topics are created in Oracle WebLogic Server console and the user created in 
Oracle WebLogic Server is assigned to MasterIndex.Admin group.

1.5 Security Guidelines for Oracle Business Intelligence Enterprise 
Edition

While installing and configuring the OBIEE Server, you should follow guidelines in 
the document Oracle® Fusion Middleware Security Guide for Oracle Business Intelligence 
Enterprise Edition 11g Release 1 (11.1.1)Part Number E10543-02.

1.5.1 Checking External Links that May Expose Account Data
It is possible to add customized links to web applications that are deployed in a web 
server. Through this mechanism, any information that can be made available through 
a URL can be made accessible to OHSCDA users. In addition, your customized links 
may support passing session parameters, such as the log-in user ID, and currently 
selected Product, Program, Study and Site to a URL. By passing these session 
parameters, you can access Web pages specific to you current selections on these 

Note: During the installation, the folder and Wallet files within are 
given restricted access at Operating System privileges; this is key 
technique by which OHSCDA secures the user_id and password. 
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attributes. However, you should be aware that in links that access external Web sites, 
passing account data and session information may pose a security risk.

1.6 Installing the Prerequisite Software
Following is a sample topology of technology components for OHSCDA:

Figure 1–2 Sample Topology

Before you can install the OHSCDA application, you must complete the following 
pre-installation tasks:

❏ Install Oracle Database 11.2.0.3

Follow the instructions in Database Installation Guide for <platform>.

❏ Install Oracle WebLogic Server 10.3.5

Follow the instructions in Oracle WebLogic Server Documentation Library.

Note: You must set the init parameter processes for the database to a 
minimum of 500.
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❏ Install Oracle Business Intelligence Enterprise Edition (OBIEE) 11.1.1.6.4 with the 
following components:

– Oracle Business Intelligence Server (Supported only on Windows and Unix)

– Oracle Business Intelligence Presentation Services (Supported on Windows 
and Unix)

– Oracle Business Intelligence Client Tools (Supported only on Windows)

Follow the instructions in Oracle Business Intelligence Infrastructure Installation and 
Configuration Guide.

❏ Install Oracle Business Intelligence Data Warehouse Administration Console 
(DAC) 10.1.3.4.1

– Install Oracle Business Intelligence Data Warehouse Administration Console 
(DAC)

Follow the instructions in Oracle Business Intelligence Data Warehouse 
Administration Console Installation, Configuration, and Upgrade Guide.

– Install patch number 14306642 

The patch is available in OHSCDA_HOME/software. Follow the instructions 
in the patch readme to install it.

❏ Install Informatica PowerCenter 9.0.1 HotFix 2

Follow the instructions in Informatica PowerCenter Installation Guide.

❏ If you plan to implement deduplication, install Oracle Healthcare Master Person 
Index (OHMPI) 1.1.2 patch 12735093.

Note: If you plan to implement deduplication, you may choose to 
use the same instance of Oracle WebLogic for deploying OHMPI 
Projects by creating a new WebLogic domain running on different port 
(which is not used by any other domains) or create a fresh instance of 
Oracle WebLogic.

You must set the MaxPermSize to 2 GB.

Important: If DAC and Informatica Servers are on different systems, 
do not copy infa_command.xml from 14306642 patch. 

Note: Oracle recommends that you enable HTTPS on middle-tier 
computers that are hosting the Web services, since otherwise the 
trusted user name and password that are passed can be intercepted.
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2Installing Oracle Health Sciences Clinical 
Development Analytics Standard Configuration

This chapter describes the OHSCDA Installation tasks that you must complete.

This chapter includes the following section:

■ Installing Oracle Health Sciences Clinical Development Analytics Standard 
Configuration on page 1

■ Managing Source System Specific Requirements on page 23

2.1 Installing Oracle Health Sciences Clinical Development Analytics 
Standard Configuration 

This section describes the OHSCDA Installation tasks that you must complete.

OHSCDA application installation consists of seven components:

■ Running the OHSCDA Installer

■ Setting Up Relational Connections in the Informatica Workflow for OHSCDA

■ Preparing a DAC Repository for OHSCDA

■ Emplacing the OHSCDA Help and Image Files

■ Preparing the OBIEE Web Catalog and Repository for OHSCDA

■ Setting Up OHMPI Projects (Optional)

2.1.1 Running the OHSCDA Installer
The basic OHSCDA components are installed using the Oracle Universal Installer. The 
installer gathers all the information about the database connectivity, data mart, 
Informatica repository by presenting a sequence of prompt screens and then installs 
the components accordingly.

Note: 

■ All references to ${DAC_INSTALL_DIR} in this document refer to 
DAC installation folder.
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Perform the following steps to install the OHSCDA application on Windows:

1. Extract the contents of the media pack into a temporary directory (For example, 
C:\ocda_temp).

2. Navigate to the \install directory under the extracted temporary folder.

3. Double-click the setup.exe file to launch the Oracle Universal Installer with the 
Welcome screen.

The installer will take you through a series of screens having fields. Attend to the 
Installer’s prompts. The following sections describe each Installer screen, and the 
required action.

4. Review the Oracle Universal Installer Welcome screen and click Next.

The Welcome screen provides information about the Oracle Universal Installer. 
The following function buttons appear on the installation screens:

■ Deinstall Products: Deinstall individual components or the entire product. 
This button appears only on the Welcome screen.

■ About Oracle Universal Installer: View the version number of the installer in 
use.

■ Help: Access detailed information about the functionality of each screen.

■ Installed Products: View currently installed products or deinstall the entire 
product or components.

■ Next: Proceed to the next screen.

■ Cancel: Cancel the installation process and exit the installer.

5. Click Next.

6. Specify Home Details screen is displayed. 

The OHSCDA Home path is the location where all the staged files from the 
Installer will get copied to the local system. This is also the location from where 
Installer would execute the database and Informatica scripts.

Example Name: OCDAHome1

Path: C:\OCDA

7. Click Next.

8. Install or Upgrade OHSCDA screen is displayed.

Specify whether you want to make a fresh installation of OHSCDA or upgrade an 
existing OHSCDA instance.

9. Click Next.

10. OHSCDA Data Warehouse Details screen is displayed.

This screen collects all the information regarding the OHSCDA data warehouse 
details.

Enter values in the following fields:

Important: Make sure that both the Oracle Database client and the 
Informatica client are available on the same system where you plan to 
execute the installer.
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OHSCDA Warehouse Target Connect Name: Logical Name for Connection to be 
created in Informatica. For example, DataWarehouse. For upgrade, this should be 
same as the one already configured in Oracle DAC and Informatica PowerCenter.

Connect String of the Warehouse: Connection of the database where OHSCDA 
DataWarehouse will be deployed.

 Default Table Space:

 Temporary Table Space:

11. Click Next and enter. OHSCDA Data Warehouse is displayed. Enter and confirm 
the System Password of the database where OHSCDA Data Warehouse will be 
deployed.

12. Click Next and enter and confirm:

OHSCDA Warehouse Schema (RXI) Password:

13. Click Next and enter and confirm:

OHSCDA RPD (RXI_RPD) Password:

14. OHSCDA Informatica PowerCenter Details screen is displayed.

This screen collects all information to connect to the Informatica server.

Enter values in the following fields:

■ Informatica Repository Name: Informatica Repository Name where you plan 
to import OHSCDA Informatica mappings.

■ Informatica Domain Name: Domain of the Informatica repository.

■ Informatica Hostname: Host name of the Informatica server.

■ Informatica Repository Port Number: Port number of the Informatica server.

■ Informatica Username with admin privileges: User with Admin privilege to 
import XMLs.

15. Click Next and enter.

Informatica Password for Admin user: Password for Informatica User with 
admin privileges.

16. OHSCDA Informatica PowerCenter Client Home Directory screen is displayed.

The Informatica PowerCenter client home path is required for the installer to run 
successfully.

Example:

Informatica PowerCenter client home: D:\Informatica\9.0.1\clients\PowerCenter 
client\client

17. Click Next.

18. Multi Source Integration History screen is displayed only if you are upgrading 
OHSCDA.

Select Yes if you previously installed OHSCDA2.1 with MSI, or else select No.

19. Click Next.

20. Multi Source Integration screen is displayed.

Select Yes to confirm that you plan to use multi source integration feature of 
OHSCDA.
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If you do not plan to use multi source integration, select No and move to step 27.

21. Click Next.

22. Oracle Healthcare Master Person Index screen is displayed.

Enter values in the following fields:

■ Connect String of OHMPI Schemas

■ Default Table Space

■ Temporary Table Space

23. Click Next and enter and confirm:

System Password for OHMPI Database: System Password of the database where 
OHMPI model will be deployed

24. Click Next and enter and confirm:

sys Password for OHMPI Database: SYS password of the database where OHMPI 
model will be deployed.

25. Click Next and enter and confirm:

Master Password for OHMPI Schemas: Master Password that will be set to all 15 
OHMPI schemas.

26. Click Next.

27. Summary screen is displayed.

Verify setting => details provided in the summary screen.

28.  Click Install.

At the completion of the installation, you can inspect the installation log at:

 <ocda_home>\install\ocda_install.log.

2.1.2 Setting Up Relational Connections in the Informatica Workflow for OHSCDA 
1. For each database that will be a source for extracting data into the OHSCDA 

warehouse, perform the following to create a Relational Connection in the 
Informatica Workflow Manager. (If you are using OHMPI, include the OHMPI 
Master Index database as one of the sources for which you create a Relational 
Connection):

a. Launch Informatica PowerCenter Workflow Manager.

b. Connect to the repository where OHSCDA Informatica mappings are 
imported.

c. Select Connections, and then select Relational to display the Relational 
Connection Browser.

d. Click New to display the Select Subtype dialog.

e. Select Oracle as database type, and then click OK. The Connection Object 
Definition dialog box is displayed with options for the selected database 
platform.

f. Enter values in the following fields according to the Source database 
connection:

Connection Name — Enter the logical connection name.
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User Name — Enter the user name that can access source data (For example, 
rxa_des for Oracle Clinical.)

Password — Enter the database password.

Connection String — Enter the Connect string for connecting to the database.

Code Page — Enter UTF-8 encoding of Unicode.

2. Connect to Informatica PowerCenter Administration Console.

3. Connect to the Informatica integration service.

4. Navigate to the Custom Properties window.

5. Enter AggSupprtWithNoPartLic in the Name field. 

6. Enter Yes in the Value field.

2.1.3 Preparing a DAC Repository for OHSCDA
You will be using CDA_Warehouse.zip file in this section.

1. Create a new DAC repository, as an Administrator.

2. Unzip OCDA_HOME\soracle.pharma.ocda.standard\DAC_Code\CDA_
Warehouse.zip onto the computer where you will run DAC client.

3. Import the OHSCDA Warehouse Application metadata.

a. Start the Data Warehouse Administration Console (DAC) client.

b. From the Tools menu select DAC Repository Management, and then select 
Import.

c. Click Change import/export folder to navigate to the folder where you 
unzipped CDA_Warehouse.zip in step 2 of the Preparing a DAC Repository 
for OHSCDA section.

d. Click OK to display the Import dialog box.

e. Select the following categories of metadata you want to import: Logical, 
Overwrite log file, and User Data. Deselect the System check box.

f. If you plan to implement deduplication, select all the applications in the 
ApplicationList else select only CDA_Warehouse application in the 
ApplicationList.

g. Click OK.

h. Enter the verification code and Yes in the secondary window that is displayed 
after the import.

Note: These values will also be required in setting up DAC. Make 
note of them to ensure that you enter the same during DAC setup.

The TNS entry for all your source and target databases should be 
added on Informatica Server.

Note: You need to repeat step a through d for each required source 
connection.
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i. You can inspect the import log in ${DAC_ INSTALL_DIR}\log\import.log to 
verify if import is successful.

4. Configure Informatica Repository Service in DAC.

a. Navigate to the Setup view, and then select the Informatica Servers tab.

b. Click New to display the Edit tab below or select an existing Informatica 
server from the list.

If you are configuring a new installation, the Informatica Servers tab will be 
empty. If you are upgrading an existing installation, the Informatica Servers 
tab might contain existing Informatica servers.

c. Enter values in the following fields:

Name — Enter the Logical name for the Informatica server (for example, 
INFA_REP_SERVER).

Type — Select Repository.

Hostname — Enter the host system name where Informatica Server is 
installed.

Server Port — Enter the port number   Informatica Server or Informatica 
Repository Server use to listen to requests.

Login — Enter the Informatica user login for the Admin user.

Password — Enter the Informatica Repository password.

Repository Name —Enter the Informatica Repository Name.

d. Test the connection to verify the settings.

e. Click Save to save the details.

5. Configure Informatica Integration Service in DAC.

a. Click New to display the Edit tab below or select an existing Informatica 
server from the list.

If you are configuring a new installation, the Informatica Servers tab will be 
empty. If you are upgrading an existing installation, the Informatica Servers 
tab might contain existing Informatica servers.

b. Enter values in the following fields:

Name — Enter the Logical name for the Informatica server (for example, 
INFA_SERVER).

Type — Select Informatica.

Service — Informatica Integration Service Name associated with the 
Informatica repository added in Step 5.

Domain — Enter the Informatica domain name.

Login — Enter the Informatica Repository user login (Admin User).

Password — Enter the Informatica Repository password.

Repository Name —Enter the Informatica Repository Name.

Note: Make sure that you use the same Login and Password that you 
have used in setting up Informatica.
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c. Test the connection to verify the settings.

d. Click Save to save the details.

6. In this step, you configure source databases (Oracle Clinical, Siebel Clinical) and 
the target database (the OHSCDA warehouse). For each database with which DAC 
will interact for OHSCDA, perform the following steps:

a. Navigate to the Setup view, and then select the Physical Data Sources tab.

b. Click New to display the Edit tab below or select an existing database 
connection from the list.

c. Enter values in the following fields:

Name — Enter the Logical name for the database connection.

Type — Select Source when you create the database connection for a 
transactional (OLTP) database. Select Warehouse when you create the database 
connection for a data warehouse (OLAP) database. Select Others when you 
create the database connection for OHMPI schema.

Connection Type — Select a connection type for the database connection.

Instance or TNS Name — Enter the Data Mart database instance name.

Table Owner — Enter the Data Mart schema name. 

Table Owner Password — Enter the Data Mart schema password.

DB Host — Enter the Data Mart host name.

Port — Enter the Data Mart host port.

Dependency Priority — Enter the user-defined priority of the data source.

Data Source Number — Enter the user-defined number of the data source.

Num Parallel Indexes Per Table — Enter a number to specify how many 
indexes are to be created in parallel. 

d. Test the connection to verify the settings.

e. Click Save to save the details.

7. If you plan to implement deduplication, create the physical data source 
connections with following details in DAC:

 Type: Other

Connection Type: Oracle (Thin).

Instance: Instance name of the database.

 Dependency Priority: Enter the user-defined priority of the data source.

 Data Source Number: Enter the user-defined number of the data source.

Note: By Default, Oracle supports Data Source Number 1 and 2 for 
Oracle Clinical and Siebel Clinical respectively.

The logical Names of the connections in DAC should be same as the 
connection names created in Informatica Workflow Manager.

OHSCDA Warehouse connection should be the same as provided 
during OHSCDA installation.
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 Num Parallel Indexes Per Table: Enter a number to specify how many indexes 
are to be created in parallel.

8. If you plan to implement deduplication, create a Flat File connection with the 
following details:

Name: FlatFile_Target

Type: Other

Connection Type: Flat File

Dependency Priority: Enter the user-defined priority of the data source.

Data Source Number: Enter the user-defined number of the data source.

Num Parallel Indexes Per Table: Enter a number to specify how many indexes are 
to be created in parallel.

9. Perform the following steps to modify the value for data sources:

a. Navigate to the Execute view, and then select the Execution Plans tab.

b. If Oracle Clinical and Siebel Clinical are your source systems, select CDA - 
Complete Warehouse from the list. 

If Oracle Clinical is your only source system, select CDA - Oracle Clinical 
Warehouse from the list. 

If Siebel Clinical is your only source system, select CDA - Siebel Clinical 
Warehouse from the list. 

c. Click Parameters subtab in the bottom pane.

Table 2–1  Physical Data Source Connection Details

Name Table Owner

OHMPI_STUDY ohmpi_study

OHMPI_STUDY_SITE ohmpi_study_site

OHMPI_STUDY_SUBJ ohmpi_study_subj

OHMPI_GEO ohmpi_geo

OHMPI_LOV ohmpi_lov

OHMPI_SITE ohmpi_site

OHMPI_INVESTIGATOR ohmpi_investigator

OHMPI_USER ohmpi_user

OHMPI_VALDTN_PROC ohmpi_valdtn_proc

OHMPI_PRODUCT ohmpi_product

OHMPI_PROGRAM ohmpi_program

OHMPI_APP_USER ohmpi_app_user

OHMPI_STUDY_REGION ohmpi_study_region

OHMPI_CRF ohmpi_crf

OHMPI_CRF_BOOK ohmpi_crf_book

Note: Table Owner Password for all the OHMPI_<dim> connections 
is the same as the Master password provided on OHMPI screen 
during OHSCDA installation.
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d. For each row with TYPE equal to DATASOURCE, in the Value field, select the 
appropriate Physical Data Source Name from the dropdown list for the field.

e. If you plan to implement deduplication, navigate to CDA - Complete Initial 
De Dup Execution Plan and CDA - Complete Warehouse De Dup Execution 
Plan.

f. Select a relevant value from the list for each of the data sources.

g. Click Save.

h. If you plan to implement deduplication, navigate to CDA - Complete 
Warehouse De Dup and set the new Data Source Name from Value list.

i. Select a relevant value from the list for each of the data sources.

j. Click Save.

DAC Configurable Parameters
Navigate to each of the containers and make sure that values are set for each of the 
available parameter.

Following is the list of DAC configurable parameters:

Note: If Oracle Clinical and Siebel Clinical are your source systems 
without deduplication, use CDA - Complete Warehouse.

If Oracle Clinical is your only source system without deduplication, 
use CDA - Oracle Clinical Warehouse.

If Siebel Clinical is your only source system without deduplication, 
use CDA - Siebel Clinical Warehouse.

If Oracle Clinical and Siebel Clinical are your source systems with 
deduplication, use CDA - Complete Initial De Dup Execution Plan 
and CDA - Complete Warehouse De Dup Execution Plan.

Table 2–2  DAC Configurable Parameters

Parameter Description

START_TS This is the last refresh time of the source tables minus prune days
(@DAC_SOURCE_PRUNED_REFRESH_TIMESTAMP)

END_TS Current Execution Plan’s actual start time adjusted to source 
database time zone minus prune days. (@DAC_ETL_START_TIM
FOR_SOURCE)

DATASOURCE_NUM_ID The ID associated with every source system. The default ID is 1 fo
Oracle Clinical and 2 for Siebel Clinical.

ENTERPRISE_ID The ID associated for every tenant. The default value is 0.

DELETE_FLOW The default value is N and set it to Y if Deletes have to be capture
in the data warehouse.

EMAIL_SUFFIX You can provide domain name as a suffix to username. For 
example: oracle.com

Prune Days This is used for setting the END_TS for incremental load.

MPI_AUTHFILE Location of the ocda.properties. Refer to Section 2.1.9, "Setting Up
Informatica Server (Optional)" for file details. 

For example: /u01/oracle/Informatica/9.0.1/server/infa_
shared/OCDA_Javalib/ocda.properties
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2.1.4 Emplacing the OHSCDA Help and Image Files 
You will be using help.zip and images.zip files in this section.

2.1.4.1 Placement of Files for Oracle WebLogic Managed Server
You need to manually deploy OHSCDA’s help and images files on Oracle WebLogic 
Managed Server. Perform the following steps:

1. Navigate to <MIDDLEWARE_
HOME>\instances\<instancename>\bifoundation\OracleBIPresentationServices
Component\coreapplication_obips1\analyticsRes\ in Oracle WebLogic Server.

2. Create the following folders at <MIDDLEWARE_
HOME>\instances\<instancename>\bifoundation\OracleBIPresentationServices
Component\coreapplication_obips1\analyticsRes\

■ s_ocda

3. Unzip help.zip from OCDA_
Home\oracle.pharma.ocda.standard\Reporting\Help to <MIDDLEWARE_
HOME>\instances\<instancename>\bifoundation\OracleBIPresentationServices
Component\coreapplication_obips1\analyticsRes\s_ocda\

4. Move customMessages and sk_ocda folders from <MIDDLEWARE_
HOME>\instances\<instancename>\bifoundation\OracleBIPresentationServices
Component\coreapplication_obips1\analyticsRes\s_ocda\ to <MIDDLEWARE_
HOME>\instances\<instancename>\bifoundation\OracleBIPresentationServices
Component\coreapplication_obips1\analyticsRes\

5. Add the following tag in instanceconfig.xml, present in <MIDDLEWARE_
HOME>\\instances\instance1\config\OracleBIPresentationServicesComponent\
coreapplication_obips1.

<UI><DefaultSkin>ocda</DefaultSkin></UI>

6. Unzip the Images.zip files from OCDA_
Home\oracle.pharma.ocda.standard\Reporting\Images to <MIDDLEWARE_
HOME>\instances\<instancename>\bifoundation\OracleBIPresentationServices
Component\coreapplication_obips1\analyticsRes\s_ocda

MPI_USER Login name of the user who can access EJBs deployed on Oracle 
WebLogic Server (same user that was provided on WebLogic screen 
during OHSCDA installation).

$OutputFile_OCDA Location of the flat files generated as part of full dedup load on 
Informatica server.

$DBConnection_SP_OLAP Database connection name of the corresponding OHMPI schema.

$DBConnection_OLAP Database connection name of the warehouse (OHSCDA Warehouse 
Target Connect Name you had specified in step 10 of Section 2.1.1, 
"Running the OHSCDA Installer,").

Note: MPI_AUTHFILE, MPI_USER, $OutputFile_OCDA, 
$DBConnection_SP_OLAP, and $DBConnection_OLAP are used only 
for deduplication.

Table 2–2 (Cont.) DAC Configurable Parameters

Parameter Description
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7. Launch Oracle WebLogic Administration Server Console.

Example: https://hostname.domain:port/console

This opens the Oracle WebLogic Server Administration Console.

8. Log in to Oracle WebLogic Server Administration Console as an Administrator.

9. In the left pane of the Administration Console, select Deployments.

10. On the left pane, click Lock & Edit.

11. In the right pane, click Install.

This opens the Install Application Assistant.

12. In the Path field browse to <MIDDLEWARE_
HOME>\instances\<instancename>\bifoundation\OracleBIPresentationServices
Component\coreapplication_obips1\analyticsRes\.

13. Select analyticsRes and click Next.

14. Select Install this deployment as an application and click Next.

15. In Available targets for analytics, select the servers in the cluster on which you 
want to deploy OHSCDA.

16. Click Next.

17. In the Deployment targets, select bi_server1.

18. Click Next.

19. Select I will make the deployment accessible from the following location option 
for <MIDDLEWARE_
HOME>\instances\<instancename>\bifoundation\OracleBIPresentationServices
Component\coreapplication_obips1\analyticsRes\ in the Source accessibility 
section.

20. Click Finish. analyticsRes should appear under the Deployments.

21. Click Activate Changes.

22. Select analyticsRes in Deployment section.

23. Click Start to view the list and select Servicing all requests. The Start Application 
Assistant page is displayed.

24. In the content pane of the new page, click Yes to start the selected deployment.

State of analyticsRes should be Active after this deployment. You may confirm the 
same on Deployments page. 

25. Log out from Oracle WebLogic Server Administration Console.

26. Log in to Oracle Enterprise Manager Fusion Middleware Control.

27. Restart the BI components.

28. Log in to OBIEE and verify the branding and help links on the dashboards.

See Also:

■ Oracle WebLogic Server Documentation Library

2.1.5 Preparing the OBIEE Web Catalog and Repository for OHSCDA
You will be using OracleClinicalDevelopmentAnalytics.zip and OCDA.rpd files in this 
section.
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1. Copy OracleClinicalDevelopmentAnalytics.zip from OCDA_
Home\oracle.pharma.ocda.standard\Reporting\Webcat to OBIEE server.

2. Copy OCDA.rpd files from OCDA_
Home\oracle.pharma.ocda.standard\Reporting\RPD to OBIEE server.

3. Unzip OracleClinicalDevelopmentAnalytics.zip in the following folder: 

■ Windows32 - <DRIVE>:\<MIDDLEWARE_
HOME>\instances\instance1\bifoundation\OracleBIPresentationServicesCo
mponent\coreapplication_obips1\catalog

■ UNIX - /<MIDDLEWARE_
HOME>/instances/instance1/bifoundation/OracleBIPresentationServicesCo
mponent/coreapplication_obips1/catalog

4. For fresh installation, create a TNS entry of OHSCDA database in %ORACLE_
BI%\network\admin. 

5. Create an ODBC entry (System DSN) to connect to (RXI) using Oracle Database 
11g client driver.

6. In the Oracle BI Administration Tool, select File, then Open, and then Offline.

7. Navigate to the OCDA.rpd, and then click Open.

 Password: Admin123

8. Click OK.

9. In the Oracle BI Administration Tool, select File, then Change Password.

10. Enter the current (old) password.

11. Enter the new password and confirm it. 

12. Confirm the new password.

13. Click OK.

14. Modify the connection pools in the RPD as following:

a. In the physical layer, expand the OHSCDA Data Warehouse node and 
double-click Connection Pool object to open Connection Pool dialog box. 

b. Set Data source name field to the ODBC entry for the warehouse you created 
in step 3.

c. Change the username to the username of the OHSCDA read-only schema. 
(RXI_RPD)

d. Change the password to the password of the OHSCDA read-only schema. 
(RXI_RPD)

e. Click OK.

f. Reconfirm the password. 

g. Click OK.

15. From the File menu, select Save to save the rpd. 

16. Click Yes for Do you wish to check global consistency?

17. Click Close in the Consistency Check Manager.

18. Click Save.

19. Click File and then click Close.
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20. Click File and then click Exit.

21. Open NQSConfig.xml found at <MIDDLEWARE_
HOME>instances\instance1\config\OracleBIServerComponent\coreapplication_
obis1.

22. Set EVALUATE_SUPPORT_LEVEL = 2. 

23. Start the Oracle WebLogic Server and BI components.

24. Open the Fusion Middleware Control URL from the system where you saved the 
OCDA.rpd in step 13. The URL includes the name of the host and the port number 
assigned during the installation. The following shows the format of the URL:

https://hostname.domain:port/em

The login page is displayed.

25. Enter the Oracle Fusion Middleware administrator user name and password and 
click Login.

26. Expand the Business Intelligence folder and select the coreapplication node.

The Overview page displays the current status of the system, by providing 
information about current availability, performance, and issues identified within 
the BI domain. The Overview page also enables you to start and stop Oracle 
Business Intelligence.

27. Navigate the Repository tab of the Deployment page.

28. Click Lock and Edit Configuration.

29. Click Close.

30. In the Upload BI Server Repository section, click Browse and navigate to select the 
RPD.

31. Enter the RPD password in Repository Password and Confirm Password fields.

32. In the BI Presentation Catalog section, enter <ORACLE_
INSTANCE>/bifoundation/OracleBIPresentationServicesComponent/<COMPO
NENT_NAME>/catalog/OCDA in the Catalog Location field.

33. Click Apply, and then click Activate Changes.

34. Return to the Business Intelligence Overview page and click Restart.

2.1.6 Configuring Maps
You will need to have a database with the sample map data set. Perform the following 
steps to download the sample map data set:

1. Go to 
http://www.oracle.com/technetwork/middleware/bi-foundation/obiee-sample
s-167534.html.

2. Navigate to OBIEE 11.1.1.3 - Sample Application.

3. Click NAVTEQ Data Bundle for OBIEE.

Note: Oracle recommends that you enable HTTPS on middle-tier 
computers that are hosting the Web services, since otherwise the 
trusted user name and password that are passed can be intercepted.
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4. Click Save.

Perform the following steps to configure maps:

1. Open the Map Viewer console available at http://<server>:9704/mapviewer.

2. Click Admin.

3. Login with the user ID and password provided during the installation.

4. Click Configuration. This will launch the mapViewerConfig.xml file.

5. In the <security_config> property of the file, make the following changes:

a. Change <proxy_enabled_hosts> property to hostname, IP address and port to 
correct values. 

For example,

<proxy_enabled_hosts>
http://localhost:9704/mapviewer,http://localhost:9704/,http://10.10.10.10:9
704/,http://10.10.10.10:9704/mapviewer
</proxy_enabled_hosts>

b. Update or add the following entries:

<disable_direct_info_request> true </disable_direct_info_request> 
<disable_info_request> true </disable_info_request> 
<disable_csf>true</disable_csf> 
<enforce_security_role> true </enforce_security_role>

6. In the 'Predefined Data Sources' section, add the following entry:

<map_data_source name="OBIEE_NAVTEQ_Sample"
jdbc_host="10.153.228.125"
jdbc_sid="cda22dv"
jdbc_port="1521"
jdbc_user="obiee_navteq"
jdbc_password="!obiee_navteq " 
jdbc_mode="thin"
number_of_mappers="6"
allow_jdbc_theme_based_foi="false"
/>

7. Click Save and Restart to save the changes and restart the services.

2.1.7 Creating Security Groups and Application Roles for OHSCDA

2.1.7.1 Creating Groups
Perform the following to create groups:

1. Launch Oracle WebLogic Server Administration Console.

2. In Oracle WebLogic Server Administration Console, select Security Realms from 
the left pane and click the realm you are configuring. For example, myrealm.

3. Select Users and Groups tab, then Groups.

Note: There are 4 entries — 2 pointing to hostname and 2 pointing to 
IP address of BI server. Ensure that all 4 entries point to the right 
server.
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4. Click New.

5. In the Create a New Group page provide the following information:

■ Name: Enter the name of the group. Group names are case insensitive but 
must be unique. See online help for a list of invalid characters.

■ (Optional) Description: Enter a description.

■ Provider: Select the authentication provider from the list that corresponds to 
the identity store where the group information is contained. 
DefaultAuthenticator is the name for the default authentication provider.

6. Click OK

The group name is added to the Group table.

7. Repeat step 4 through 6 with the following values:

2.1.7.2 Creating Application Roles
Perform the following to create groups:

1. Log in to Oracle Enterprise Manager Fusion Middleware Control.

2. From the target navigation pane, open Business Intelligence and select 
coreapplication.

3. Right-click coreapplication, then select Security to display a submenu with 
Application Policies and Application Roles as options.

4. Select Application Roles. The Application Roles page is displayed.

5. Click Create to display the Create Application Role page. Complete the fields as 
follows:

In the General section:

■ Role Name - Enter the name of the Application Role

■ (Optional) Display Name - Enter the display name for the Application Role.

■ (Optional) Description - Enter a description for the Application Role.

6. In the Members section, select Add Group. To search in the dialog box that 
displays:

1. Click the blue button to search. It will display a list of all the groups.

2. Select from the results returned in the Available box.

3. Use the shuttle controls to move the desired name to the Selected box.

4. Click OK to return to the Create Application Role page.

5. Repeat steps 5 through 9 for all the Roles listed in the following table: 

Table 2–3  Security Group Parameters

Name Description Provider

OCDA-CRA (Optional) DefaultAuthenticator

OCDA-DataManager (Optional) DefaultAuthenticator

OCDA-ExecutiveManager (Optional) DefaultAuthenticator

OCDA-RegionManager (Optional) DefaultAuthenticator

OCDA-StudyManager (Optional) DefaultAuthenticator

OCDA-WebcatAdim (Optional) DefaultAuthenticator
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2.1.8 Setting Up OHMPI Projects (Optional)
Follow the steps in this section only if you plan to implement deduplication. You must 
install Oracle client on the system where you intend to carry out OHMPI related 
cleanser and loader process. To set up OHMPI projects:

1. Navigate to OCDA Home.

2. Locate the zipped OHMPI Project files and move all the zipped files to a system 
where you plan to import and modify projects using NetBeans.

3. Copy and unzip all the 15 project files.

4. On the NetBeans toolbar, click Open Project.

5. Navigate to the folder where the OHMPI projects are unzipped.

6. Select a project.

7. Select the check box Open Required Projects and click Open Project.

8. Once the project is imported, right-click the main project file (OCDA_<dim>) in the 
Projects window.

9. Right-click the same project and select Clean.

10. Right-click and select Generate Master Index Files.

11. Right-click and select Build.

12. Navigate to <project_home>/src/DatabaseScript, where project_home is the 
location of the master person index project files. 

13. Connect to the project specific database schema, for example, for OCDA_Study 
project use ohmpi_study as username and the master password provided on 
Oracle Healthcare Master Person Index screen during OHSCDA installation. 

14. Execute the following files in the following order:

1. create.sql

2. systems.sql

3. codelist.sql

Table 2–4  Application Roles and Groups

Role Name Description Groups

OCDA-CRA (Optional) OCDA-CRA

OCDA-DataManager (Optional) OCDA-DataManager

OCDA-ExecutiveManager (Optional) OCDA-ExecutiveManager

OCDA-RegionManager (Optional) OCDA-RegionManager

OCDA-StudyManager (Optional) OCDA-StudyManager

OCDA-WebcatAdim (Optional) OCDA-WebcatAdim

Note: 

The systemcode in systems.sql must be same as data source name 
provided in W_RXI_DATASOURCE_S. Note that systemcode is 
case-sensitive.
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15. Repeat steps 4 through 14 for each of the 15 OHMPI projects.

2.1.8.1 Creating JDBC Data Resources for an MPI Application Project for Oracle
This section provides instructions for creating the JDBC data resources and defining 
the JDBC connections for an MPI Application Project for Oracle.

1. For instructions on how to start and stop Oracle WebLogic Server, see Starting and 
Stopping Servers: Quick Reference at 
http://download.oracle.com/docs/cd/E14571_01/wls.htm.

2. Log in to Oracle WebLogic Server Administration Console.

3. On the left panel, under Domain Structure, expand Services, and then choose Data 
Sources.

A summary of JDBC Data Sources appears in the right panel.

4. To create a new JDBC Data Source click New at the bottom of the right panel.

Settings for a new JDBC Data Source appear in the right panel of the page. It is 
here that you will create a new JDBC Data Source.

5. In the Name field, type <Application name>DataSource.

The name you enter here will propagate elsewhere, so choose a name that is 
meaningful (for example, StudyDataSource).

6. In the JNDI Name field, type jdbc/<Application name>DataSource.

Important: 

For OCDA_Geography project, execute Create_with_LID_changes.sql 
instead of create.sql.

For OCDA_User project, execute create_lidchange.sql instead of 
create.sql.

Table 2–5  Application Names for Each Project

Project Name Application Name

OCDA_StudyStudy Study

OCDA_Study_Site Study_Site

OCDA_Study_Subject subject

OCDA_Geography Geography

OCDA_LOV LOV

OCDA_Site Site

OCDA_Investigator Investigator

OCDA_User OCDA_User

OCDA_Valdtn OCDA_Valdtn

OCDA_Product Product

OCDA_Program Program

OCDA_APP_USER App_User

OCDA_Study_Region Study_Region

OCDA_CRF CRF

OCDA_CRF_BOOK CRF_BOOK
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Use the name you entered in step 5 (for example, jdbc/StudyDataSource).

7. In the Database Type list, choose the appropriate type (for example: Oracle).

8. Click Next.

9. In the Database Driver list, choose the appropriate driver; for example: Oracle’s 
Driver (Thin XA) for Instance Connections; Versions: 9.0.1; 9.2.0; 10, 11.

10. Click Next.

11. Click Next.

12. In the Database Name field, type a name for the database to which you want to 
connect (for example: OCDA_Study).

13. In the Host Name field, type the name or the IP address of the database server (for 
example: localhost).

14. In the Port field, type the port on the database server that is used to connect to the 
database (for example: 1521).

15. In the Database User Name field, type the database account user name you want 
to use to create database connections (for example: ohmpi_study).

16. In the Password field, type a password for your database account to use to create 
database connections.

17. In the Confirm Password field, re-type the password to confirm it.

18. Click Next.

The Settings for StudyDataSource page appears in the right panel.

19. Click the Connection Pool tab, click Test Configuration, and then click Next.

Select Targets window appears on the Create a New JDBC Data Source page in the 
right panel. You can select one or more targets to deploy the new JDBC data 
source.

20. In the Servers check list, select one or more target servers and click Finish.

21. Repeat the above steps to create jdbc/StudySequenceDataSource.

2.1.8.2 Creating JMS Resources for an MPI Application Project
JMS servers act as management containers for the queues and topics in the JMS 
modules that are targeted to them.

The following procedure includes instructions for creating JMS resources, which 
includes a:

■ JMS Server

■ JMS Module

■ JMS Connection Factory in the specific JMS Module

■ JMS Topic in the specific JMS Module

2.1.8.2.1 To Create JMS Server  

Note: If you do not select a target, the data source will be created but 
not deployed. You will need to deploy the data source at a later time.
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1. On the left panel, under Domain Structure, expand Services, click Messaging, and 
then choose JMS Servers.

A Summary of JMS Servers appears in the right panel. It includes a table that 
summarizes the JMS servers that have been created in the current WebLogic Server 
domain.

2. In the table of previously created JMS Servers, click New.

The Create a New JMS Server panel appears.

3. In the Name field, type the name for your new JMS Server.

4. Click Next.

Select Targets appears in the right panel under Create a New JMS Server.

5. From the Target list select a target server instance or migratable target on which 
you want to deploy the JMS Server.

6. Click Finish.

2.1.8.2.2 To Create JMS Module  

1. On the left panel, under Domain Structure, expand Services, click Messaging, and 
then choose JMS Modules.

The JMS Modules panel appears.

2. In the JMS Modules table, click New to add a new JMS Module.

The Create JMS System Module panel appears.

3. In the Name field, type the new JMS Module name.

4. Click Next.

Select Targets appears in the right panel under Create a New JMS System Module.

5. In the Servers area, select the server or cluster on which you want to deploy this 
JMS system module.

6. Click Finish.

2.1.8.2.3 To Create JMS Connection Factory  

Note: This name already exists in the table of previously created JMS 
Servers (in the example, StudyJMSServer).

Note: The default server instance is exampleServer.

Note: Remain consistent to the name chosen for the JDBC Data 
Source and the JMS Server (in the previous examples the key word 
was Study, making this name StudyJMSModule).

Note: Retain the default, exampleServer.
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1. On the left panel, under Domain Structure, expand Services, click Messaging, and 
then choose JMS Modules.

2. Choose the JMS Module (in the example, StudyJMSModule) from the table of JMS 
Modules.

The Settings for StudyJMSModule page appears in the right panel.

3. In the Summary of Resources table, click New.

4. Under the Type column in the Summary of Resources table choose Connection 
Factory and click Next.

Another panel of Create a New JMS System Module Resource appears.

5. In the Name field, type StudyOutBoundSender.

6. In the JNDI Name field, type jms/StudyOutBoundSender.

7. Select XA Connection Factory Enabled and click Save.

8. Click Next

9. In the Target field, retain the default server instance, which is exampleServer, and 
click Finish.

2.1.8.2.4 To Create JMS Topic  

1. On the left panel, under Domain Structure, expand Services, click Messaging, and 
then choose JMS Modules.

2. In the right panel, choose the JMS Module you created (in the example, 
StudyJMSModule) from the table of JMS Modules.

Settings for StudyJMSModule appear in the right panel with a Summary of 
Resources table.

3. In the Summary of Resources table, click New, select Topic, and then click Next.

The Create a New JMS System Module Resource panel appears on the right side of 
the window. Use this panel to set the properties that identify the new topic.

4. In the Name field, under JMS Destination Properties, type <name>Topic (for 
example, StudyTopic).

5. Set jms/StudyTopic as the JNDI Name and click Next.

The Create a New JMS System Module Resource page appears in the right panel. 
Use this page to set the properties that will be used to target your new JMS system 
module resource.

6. In the Subdeployments list, select None and click Create a New Subdeployment.

7. In the Subdeployment Name field, type <name>Topic (for example, StudyTopic), 
and click OK.

8. In the Targets table of JMS Servers, select <name>JMSServer (for example, 
StudyJMSServer).

9. Click Finish.

2.1.8.3 Deploying and Running Applications on Oracle WebLogic Server
This procedure leads you through the steps to deploy and run an MPI Application on 
Oracle WebLogic Server.

2.1.8.3.1 To Deploy and Run Applications on an Oracle WebLogic Server  
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1. On the left panel of the WebLogic Server Administration Console, under Domain 
Structure, select Environment and then choose Deployments.

The Summary of Deployments panel appears.

2. On the right side of the panel under Deployments, click Install.

A Summary of Deployments panel with a Deployments table containing a list of 
EAR files appears.

3. Locate your application EAR and click Next.

The Install Application Assistant page appears in the right panel.

4. Locate the deployment you want to install and prepare for deployment.

5. Click Next.

6. Click Finish.

7. Launch Master Index Data Manager (MIDM).

8. From a web browser, enter the following:

■ For MPI Application: https://localhost:7001/StudyMIDM 

9. Log in using your user name and password.

2.1.8.4 Setting Up the User
In this step you create the MasterIndex.Admin and Administrator groups, and then 
create a new user within the two groups.

1. On the left panel, under Domain Structure, expand Services, and then choose 
Security Realms.

2. In the table on the Summary of Security Realms panel, click myrealm that is the 
name of the realm.

The Settings for myrealm panel appears.

3. Select the Users and Groups tab and then click Groups.

4. In the Groups table, click New.

5. In the Name field, type MasterIndex.Admin and click OK.

Tip: Select the file path that represent the application root directory, 
archive file, exploded archive directory, or application module 
descriptor that you want to install. You can also enter the path of the 
application directory or file in the Path field.

Note: Only valid file paths are displayed. If you cannot find your 
deployment files, upload your file(s) and/or confirm that your 
application contains the required deployment descriptors.

Note: When deploying an MPI EAR file through the WebLogic 
Admin Console, under Security make sure that you choose DD Only. 
If you choose one of the other options, you will not be able to log into 
the MIDM.
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6. In the Groups table, click New.

7. In the Name field, type Administrator and click OK.

8. On the Settings for myrealm panel, select Users and Groups and then Users.

9. In the Users table, click New.

10. Type a name and a password for the new user you are creating and click OK.

11. Select User Group.

12. To add the two groups you created to the user you created, from the Available list, 
drag MasterIndex.Admin to the Chosen list, and then drag Administrator to the 
Chosen list.

2.1.9 Setting Up Informatica Server (Optional)
Follow the steps in this section only if you plan to implement deduplication. Perform 
the following steps at the Informatica server:

1. Set the OHMPI project related Jar files on Informatica Server:

1. Navigate to $PMRootDir on Informatica server and create a folder OCDA_
Javalib to store common Jar files. For example, 
/u01/oracle/Informatica/9.0.1/server/infa_shared/OCDA_Javalib

2. Copy wlfullclient.jar file from <WebLogic home>/server/lib folder to folder 
created in the step 1.

If wlfullclient.jar is not available, run the following command from <WebLogic 
home>/server/lib dir to generate wlfullclient.jar 

java -jar wljarbuilder.jar

2. Create a file ocda.properties file with the following settings to store connection 
information of Oracle WebLogic server and place it under OCDA_Javalib.

INITIAL_CONTEXT_FACTORY=weblogic.jndi.WLInitialContextFactory

PROVIDER_URL= <URL> of the Oracle WebLogic server

SECURITY_PRINCIPAL=<username> same username as provided on WebLogic 
Details Screen during OHSCDA installation

CDA_STORE_URL=/u01/oracle/Informatica/9.0.1/server/infa_shared/OCDA_
Javalib/CDA_SEC_STORE

3. Navigate to $PMRootDir on Informatica server and create 15 OHMPI project 
specific folders. For example, /u01/oracle/Informatica/9.0.1/server/infa_
shared/OCDA_Javalib/OCDA_Study.

Following are the folder names:

■ OCDA_INVESTIGATOR

■ OCDA_SITE

■ OCDA_CRF_BOOK

Note: Repeat steps in Section 2.1.8.1, "Creating JDBC Data Resources 
for an MPI Application Project for Oracle", Section 2.1.8.2, "Creating 
JMS Resources for an MPI Application Project", and Section 2.1.8.3, 
"Deploying and Running Applications on Oracle WebLogic Server" for 
each of the 15 OHMPI projects.
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■ OCDA_USER

■ OCDA_VALDTN

■ OCDA_CRF

■ OCDA_STUDY

■ OCDA_PROGRAM

■ OCDA_STUDY_REGION

■ OCDA_APP_USER

■ OCDA_GEOGRAPHY

■ OCDA_LOV

■ OCDA_STUDY_SITE

■ OCDA_PRODUCT

■ OCDA_STUDY_SUBJECT

Copy the following jar files from OHMPI Projects lib folder to the respective 
folders created in step 3.

mpi-client-ocda_study.jar (Project name will be the part of this Jar file)

index-core.jar

net.java.hulp.i18n.jar

4. Navigate to OCDA_HOME folder locate, copy and unzip CDA_SEC_STORE.zip to 
$PMRootDir/OCDA_Javalib on Informatica server.

5. Create Secret Store Wallet and User Management.

OHSCDA needs to store the OHMPI username and password that is used to set 
the Context and call the OHMPI EJB during incremental dedup ETL execution. 
This user name and password is encrypted and stored in secret store wallet files. 
Following are the steps to store this information.

1. Navigate to the CDA_SEC_STORE directory; execute CDA_OHMPI_
CREATE_SSTORE.sh

2. Enter the User ID and password that are used for the OHMPI MIDM login.

3. Provide read and execute privileges to Operating system user that starts 
Informatica server services.

2.2 Managing Source System Specific Requirements 

2.2.1 Fine-tuning Oracle Clinical Settings
To optimize source system integration with OHSCDA, perform the following:

Note: To change the password for an existing user entry in the wallet 
file, re-enter the same User ID with a new password. This updates the 
password in the wallet file.
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1. For OC 4.6, navigate to Informatica Relational Connections > OC Connection 
Object > Attribute in Informatica Workflow Manager.

2.  Set Connection Environment SQL value as:

■ Oracle Database 11.2.0.2—alter session set optimizer_features_enable='11.2.0.2'

■ Oracle Database 11.2.0.3—alter session set optimizer_features_enable='11.2.0.3'

■ Oracle Database 11.1.0.7—alter session set optimizer_features_enable='11.1.0.7'

3. Create the following indexes:

■  Function based index on DISCREPANCY_ENTRIES - NVL 
("MODIFICATION_TS", "CREATION_TS")

■  Function based index on DISCREPANCY_ENTRY_REVIEW_HIST - NVL 
("NEXT_STATUS_TS", "CREATION_TS")

■ Function based index on RECEIVED_DCIS - NVL ("MODIFICATION_TS",  
"RECEIVED_DCI_ENTRY_TS")

■ Function based index on RECEIVED_DCMS - NVL ("MODIFICATION_TS", 
"RECEIVED_DCM_ENTRY_TS") 

2.2.2 Handling Deletions in Siebel Clinical
OHSCDA provides an optional feature to manage hard deletion of records in Siebel 
Clinical. You create triggers in the source system to handle deletion of records. To do 
this:

1. Navigate to the temporary staging location where the OHSCDA installer copies 
the installation files.

2. Connect to the Siebel Clinical data source and run the OCDA_
HOME/oracle.pharma.ocda.standard/Delete_Script/ocda_sc_del_triggers.sql 
script delivered with OHSCDA. This script creates the RXI_DELETE_LOG_S table 
and triggers on tables provided as input. The following are the tables in Siebel 
Clinical for which OHSCDA supports creating triggers:

■ S_CL_PTCL_LS

■ S_PROD_INT

■ S_CL_SUBJ_LS

■ S_CONTACT

■ S_CL_PGM_LS

■ S_PTCL_SITE_LS

■ S_EVT_ACT

■ S_ORG_EXT

Provide a list of comma separated values of table names for which the triggers 
needs to be created as the script's input. For example, S_CL_PTCL_LS, S_PROD_
INT, and S_CL_SUBJ_LS. The tables names that you provide can only be a subset 
of the tables listed above.

For information on how to handle deletion of records in Siebel Clinical, refer to Oracle 
Clinical Development Analytics Administrator's Guide (Chapter 2, Extract Transform Load 
Programs).
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3Upgrading Oracle Health Sciences Clinical 
Development Analytics

This chapter provides procedures that explain how to upgrade OHSCDA. It includes 
the following sections:

■ Migrating from OHSCDA 2.1 (Plus Configuration) to OHSCDA 2.2 (Standard 
Configuration) on page 1.

■ Upgrading from OHSCDA 2.1 Standard to OHSCDA 2.2 Standard on page 1.

3.1 Migrating from OHSCDA 2.1 (Plus Configuration) to OHSCDA 2.2 
(Standard Configuration)

If you are migrating from OCDA 2.1 (Plus Configuration) to OHSCDA 2.2 (Standard 
Configuration), perform the following steps:

1. Install OHSCDA 2.2 (Standard Configuration). Refer to Section 2.1.1, "Running the 
OHSCDA Installer," for more details.

2. If you made any modifications to database tables or ETL System Dependent 
Extract (SDE) or System Independent load (SIL) in your Plus Configuration, apply 
the same changes to their counterparts in the Standard Configuration (Informatica 
PowerCenter and DAC).

3. Perform an initial load of data from the transactional sources.

a. Perform a full load of the warehouse using CDA- Warehouse Execution Plan.

3.2 Upgrading from OHSCDA 2.1 Standard to OHSCDA 2.2 Standard
The Installer automates the upgrade of the warehouse and the Informatica mappings. 
After running the Installer, carry out the remaining steps manually.

3.2.1 Upgrading Warehouse Database Version and Reconfiguring OBIEE and DAC 
Client

1. Upgrade the warehouse database version from 11.2.0.2 to 11.2.0.3.

Note: OHASCDA 2.2 Standard is certified on Oracle Database 
11.2.0.3. For detailed certification information, refer to Finding 
Certification Information.
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2. Ensure that your OBIEE version is 11.1.1.6.4.

3. Reconfigure OBIEE and DAC client, pointing to the new upgraded warehouse 
database version 11.2.0.3.

3.2.2 Running the Installer in Upgrade Mode
1. Run the OHSCDA Installer as described in the section Section 2.1.1, "Running the 

OHSCDA Installer."

After the installation is completed, you can inspect the installation log at:

<ocda_home>\install\ocda_install.log.

3.2.3 Next Steps
After running the installer, perform the following steps:

1. Perform the steps listed in the section Section 3.2.5, "Migrating Data from 
OHSCDA 2.1 to OHSCDA 2.2 (Standard Configuration)."

2. Perform the steps listed in the following sections:

If you plan to use deduplication:

■ Install OHMPI, following the instructions in 1Section 1.6, "Installing the 
Prerequisite Software"

■ Add the OHMPI master index database as an Informatica source, following 
the instructions in section Section 2.1.2, "Setting Up Relational Connections in 
the Informatica Workflow for OHSCDA"

■ Add the OHMPI master index database as a DAC source, following the 
instructions in steps 7, 8, and 9 of Section Section 2.1.3, "Preparing a DAC 
Repository for OHSCDA"

■ Section 3.2.4, "Emplacing the OHSCDA Help and Image Files,"

■  Section 2.1.5, "Preparing the OBIEE Web Catalog and Repository for 
OHSCDA,"

■ Section 2.1.6, "Configuring Maps,"

■  Section 2.1.7, "Creating Security Groups and Application Roles for OHSCDA," 

■  Section 2.1.8, "Setting Up OHMPI Projects (Optional)," 

■  Section 2.1.9, "Setting Up Informatica Server (Optional)," 

If you do not plan to use deduplication:

■  Section 2.1.4, "Emplacing the OHSCDA Help and Image Files," 

■  Section 2.1.5, "Preparing the OBIEE Web Catalog and Repository for 
OHSCDA,"

Note: If you are upgrading from OHSCDA 2.1 and have modified 
the OBIEE repository or Web Catalog, merge these objects. For more 
information, refer to Oracle® Fusion Middleware Metadata Repository 
Builder's Guide for Oracle Business Intelligence Enterprise Edition 11g 
Release 1.
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■ Section 2.1.6, "Configuring Maps,"

■  Section 2.1.7, "Creating Security Groups and Application Roles for OHSCDA," 

3.2.4 Emplacing the OHSCDA Help and Image Files 
You will be using help.zip and images.zip files in this section.

3.2.4.1 File Placement for Oracle WebLogic Managed Server
You should manually deploy OHSCDA’s help and images files on Oracle WebLogic 
Managed Server. Perform the following steps to do so:

1. Navigate to <MIDDLEWARE_
HOME>\instances\<instancename>\bifoundation\OracleBIPresentationServices
Component\coreapplication_obips1\analyticsRes\ in Oracle WebLogic Server.

2. If not already present, create the following folders at <MIDDLEWARE_
HOME>\instances\<instancename>\bifoundation\OracleBIPresentationServices
Component\coreapplication_obips1\analyticsRes\

■ s_ocda

3. Unzip help.zip from OCDA_
Home\oracle.pharma.ocda.standard\Reporting\Help to <MIDDLEWARE_
HOME>\instances\<instancename>\bifoundation\OracleBIPresentationServices
Component\coreapplication_obips1\analyticsRes\s_ocda\.

4. Move customMessages and sk_ocda folders from <MIDDLEWARE_
HOME>\instances\<instancename>\bifoundation\OracleBIPresentationServices
Component\coreapplication_obips1\analyticsRes\s_ocda\ to <MIDDLEWARE_
HOME>\instances\<instancename>\bifoundation\OracleBIPresentationServices
Component\coreapplication_obips1\analyticsRes\.

5. If not already present, add the following tag in instanceconfig.xml, present in 
<MIDDLEWARE_
HOME>\\instances\instance1\config\OracleBIPresentationServicesComponent\
coreapplication_obips1.

<UI><DefaultSkin>ocda</DefaultSkin></UI>

6. Unzip the Images.zip files from OCDA_
Home\oracle.pharma.ocda.standard\Reporting\Images to <MIDDLEWARE_
HOME>\instances\<instancename>\bifoundation\OracleBIPresentationServices
Component\coreapplication_obips1\analyticsRes\s_ocda.

7. Launch Oracle WebLogic Administration Server Console.

Example: https://hostname.domain:port/console

This opens the Oracle WebLogic Server Administration Console.

8. Log in to Oracle WebLogic Server Administration Console as an Administrator.

9. In the left pane of the Administration Console, select Deployments.

Note: If you are upgrading from OHSCDA 2.1 and have modified 
the OBIEE repository or Web Catalog, merge these objects. For more 
information, refer to Oracle® Fusion Middleware Metadata Repository 
Builder's Guide for Oracle Business Intelligence Enterprise Edition 11g 
Release 1.
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10. On the left pane, click Lock & Edit.

11. In the right pane, click Update.

This opens the Install Application Assistant.

12. In the Path field browse to <MIDDLEWARE_
HOME>\instances\<instancename>\bifoundation\OracleBIPresentationServices
Component\coreapplication_obips1\analyticsRes\.

13. Select analyticsRes and click Next.

14. Click Finish.

15. Click Activate Changes.

16. Select analyticsRes in Deployment section.

17. Click Start to view the list and select Servicing all requests. The Start Application 
Assistant page is displayed.

18. In the content pane of the new page, click Yes to start the selected deployment.

State of analyticsRes should be Active after this deployment. You may confirm the 
same on Deployments page. 

19. Log out from Oracle WebLogic Server Administration Console.

20. Log in to Oracle Enterprise Manager Fusion Middleware Control.

21. Restart the BI components.

22. Log in to OBIEE and verify the branding and help links on the dashboards.

See Also:

■ Oracle WebLogic Server Documentation Library

3.2.5 Migrating Data from OHSCDA 2.1 to OHSCDA 2.2 (Standard Configuration)
Perform the following steps to migrate data from OCDA 2.1 to OHSCDA 2.2 (Standard 
Configuration):

1. Log in to the OCDA Target database instance using system user.

2. Grant privileges to the following databases for creating the database link.

For example: 

GRANT create database link TO <rxi_user>;
GRANT create database link TO ohmpi_study_site;
GRANT create database link TO ohmpi_study_region;

3. Log into your CDA data warehouse schema.

4. Create the following four database links:

The dblink name should be oc_dblink for Oracle Clinical Source, sc_dblink for 
Siebel Clinical Source, ohmpi_study_site for OHMPI Study Site, and ohmpi_
study_region for OHMPI Study_Region.

Note: Data migration scripts are available in OCDA_
HOME\oracle.pharma.ocda.standard\DataModels\OCDA_2.1_to_
2.2_Data_Migration_scripts.zip.
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Example (OC):

create database link <oc_dblink>

connect to <oc_username> identified by <oc password>

using 
'(DESCRIPTION=(ADDRESS=(PROTOCOL=tcp)(HOST=<hostname>)(PORT=<portno>))(
CONNECT_DATA=(SID=<sidname>)))';

Example (SC):

create database link <sc_dblink>

connect to <sc_username> identified by <sc password>

using 
'(DESCRIPTION=(ADDRESS=(PROTOCOL=tcp)(HOST=<hostname>)(PORT=<portno>))(
CONNECT_DATA=(SID=<sidname>)))';

Example (OHMPI Study Site):

create database link < ohmpi_study_site>

connect to <ohmpi_study_site_username> identified by <ohmpi_study_site_
password>

using 
'(DESCRIPTION=(ADDRESS=(PROTOCOL=tcp)(HOST=<hostname>)(PORT=<portno>))(
CONNECT_DATA=(SID=<sidname>)))';

Example (OHMPI Study Region):

create database link < ohmpi_study_region>

connect to <ohmpi_study_region_username> identified by <ohmpi_ohmpi_
study_region_password>

using 
'(DESCRIPTION=(ADDRESS=(PROTOCOL=tcp)(HOST=<hostname>)(PORT=<portno>))(
CONNECT_DATA=(SID=<sidname>)))';

5. Execute Dimension Denormalization scripts:

1. Execute update_dim_oc_denorm_id.sql.

2. Execute update_dim_sc_denorm_id.sql.

6. If you had implemented MSI (Multi Source Integration) in CDA 2.1, perform step 
7 through 14 else move to step 15 onwards.

7. Log in to OCDA OHMPI_STUDY_SITE schema.

8. Create the following two database links:

The dblink name should be oc_dblink for Oracle Clinical Source and sc_dblink for 
Siebel Clinical Source.

Example (OC):

create database link <oc_dblink>

connect to <oc_username> identified by <oc password>

using 
'(DESCRIPTION=(ADDRESS=(PROTOCOL=tcp)(HOST=<hostname>)(PORT=<portno>))(
CONNECT_DATA=(SID=<sidname>)))';

Example (SC):
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create database link <sc_dblink>

connect to <sc_username> identified by <sc password>

using 
'(DESCRIPTION=(ADDRESS=(PROTOCOL=tcp)(HOST=<hostname>)(PORT=<portno>))(
CONNECT_DATA=(SID=<sidname>)))';

9. Execute OHMPI Study Site scripts:

a. Execute alter_ohmpi_study_site.sql.

b. Execute update_ohmpi_study_site.sql.

10. Log in to OCDA OHMPI_STUDY schema. 

11. Execute OHMPI Study scripts:

1. Execute script alter_ohmpi_study.sql.

12. Log in to OCDA OHMPI_STUDY_REGION schema. 

13. Create the following database link:

The dblink name should be sc_dblink for Siebel Clinical Source.

Example (SC):

create database link <sc_dblink>

connect to <sc_username> identified by <sc password>

using 
'(DESCRIPTION=(ADDRESS=(PROTOCOL=tcp)(HOST=<hostname>)(PORT=<portno>))(
CONNECT_DATA=(SID=<sidname>)))';

14. Execute OHMPI Study Region scripts:

1. Execute alter_ohmpi_study_region.sql.

2. Execute update_ohmpi_study_region.sql.

15. Log into your CDA warehouse schema.

16. Execute the following migration scripts:

update_mdm_table.sql

upd_win_data_into_ref_dim.sql

load_region_dim.sql

17. Execute the commit statement.

18. Execute the migration script update_fact_wid.sql.

19. After data validation, delete the temporary table and db links by executing the 
following script:

drop_tables_and_dblinks.sql

3.2.6 Setting Up the Informatica Server for Upgrade
If you plan to use Dedup, ensure the Informatica Server is setup as defined in 
following sections: 

■ Section 2.1.9, "Setting Up Informatica Server (Optional),"
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3.2.7 Redeploy following OHMPI projects into Oracle WebLogic
Redeploy the following OHMPI projects into Oracle WebLogic server: 

3.2.8 Upgrading the Existing DAC Environment
Perform the following steps to upgrade the existing DAC environment:

3.2.8.1 Back Up the Existing DAC Repository
Perform the following steps to back up the existing DAC repository:

1. Export the current DAC repository by connecting to DAC repository as an 
Administrator:

a. Start the Data Warehouse Administration Console (DAC) client.

b. From the Tools menu select DAC Repository Management, and then select 
Export.

c. Click Change import/export folder to navigate to an appropriate location.

d. Click OK to display the Export dialog box.

e. Select the following categories of metadata you want to import: Logical, 
Overwrite log file, and User Data.

f. Deselect the System check box.

g. Select CDA_Warehouse application in the ApplicationList.

h. Click OK.

3.2.8.2 Upgrade the Current DAC Repository
1. Connect to the existing DAC repository, as Administrator. 

2. Unzip %ocda_home%\ oracle.pharma.ocda.standard\DAC_Code\CDA_
Warehouse.zip into a local folder.

3. Start the Data Warehouse Administration Console (DAC) client.

4. Log in to Data Warehouse Administration Console (DAC) client as an 
Administrator.

5. Make note of current logical names of the physical data sources. You will need 
them later during the upgrade.

6. Change logical names of the physical data sources to Oracle_Clinical, Siebel_
Clinical, and Datawarehouse in DAC (depending on the source system 
connections used during OCDA 2.1).

Table 3–1  List of Projects

Project Name

OCDA_Study_Site

OCDA_Study_Region

OCDA_Study

Note: Before upgrading or backing up, note down all parameter and 
connection values set in DAC containers to reverify these values after 
DAC upgradation.



Upgrading from OHSCDA 2.1 Standard to OHSCDA 2.2 Standard

3-8 Oracle Health Sciences Clinical Development Analytics Secure Installation and Configuration Guide

7. Navigate to Tool, then DAC Repository Management, and then Upgrade/Merge 
Wizard.

8. From the Start Process list, select Replace Base and then click OK.

The Import Source System Container dialog box appears.

9. Click Change import/export folder to navigate to the directory where you 
unzipped CDA_Warehouse.zip in Step 1 of this sub section.

10. Select the container you want to upgrade. It should be same as the one available 
for you in the Source System Container list. For example, CDA_Warehouse) and 
click OK.

11. In the Importing Tables dialog box, re-type the text in the text box to confirm you 
want to proceed, and click Yes.

When the import process is complete, the Importing Tables dialog box tells you 
how long the process took.

12. Click OK.

The Create Difference Report dialog box appears.

13. Create the Difference Report to view the differences between the new and existing 
DAC repositories.

a. Enter a name for the Difference Report, or leave the default name.

b. Select the appropriate existing container.

c. (Optional) Enter a description for the Difference Report. 

d. Click OK.

When the Difference Report is complete, the Creating Difference Report dialog 
box tells you how long the process took. 

e. Click OK.

The View Difference Report dialog box displays the differences between the 
new and existing DAC repositories.

f. Click Merge.

The Merge dialog box appears and lists the details of the merge.

g. Click Merge to begin the merge process.

h. Click OK in the Merging Repositories dialog box when the merge process is 
complete.

i. Verify Physical Data Source connection for the source and target connections.

3.2.9 Importing the OHSCDA Warehouse Application Metadata into the DAC Repository
1. Start the Data Warehouse Administration Console (DAC) client.

2. From the Tools menu, select DAC Repository Management, and then select 
Import.

3. Click Change import/export folder to navigate to the folder where you unzipped 
CDA_Warehouse.zip.

4. Click OK to display the Import dialog box.

5. Select the following categories of metadata you want to import: Logical, 
Overwrite log file, and User Data.
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6. Deselect the System check box.

7. If you plan to implement deduplication, select all the applications in the 
ApplicationList else select only CDA_Warehouse application in the 
ApplicationList.

8. Click OK.

9. Enter the verification code and OK in the secondary window that is displayed 
after the import. 

10. You can inspect the import log in ${DAC_ INSTALL_DIR}\log\import.log to verify 
if import is successful.

You can ignore the following entry in the log:

ORA-00001: unique constraint (<dac_schema>.W_ETL_<table_name>_U1) 
violated

11. Revert the logical names of the physical data sources to what you had noted in 
step 5 of Section 3.2.8.2, "Upgrade the Current DAC Repository,".

12. Enable task level parameter in DAC.

a. Select CDA_Warehouse application in the ApplicationList.

b. Click Tasks tab in the top pane.

c. Select a task.

d. Click Parameters subtab in the bottom pane.

e. Deselect Inactive for START_TS parameter.

f. Click Save.

g. Repeat steps 3, 4, and 5 for each of the following tasks:

13. Add task level parameter in DAC.

1. Select CDA_Warehouse application in the ApplicationList.

2. Click Tasks tab in the top pane.

3. Select a task.

4. Click Parameters subtab in the bottom pane.

5. Click New.

6. Enter Name as START_TS, Select Data Type as TimeStamp, and Select Load 
Type as Incremental.

7. Click the Value field icon to open a new window.

Note: Ensure that the source and target connections names are same 
as the relational connection names you created in Informatica 
Workflow Manager.

Table 3–2  List of Tasks

Task Name

SDE_SC_Study_Team_Dim

SDE_SC_Study_Region_Team_Dhls
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8. Select Static. In the date field enter Jan,1 1900 12:00:00AM.

9. In the Function drop-down list select Custom Format as Format type and 
enter MM/DD/YYYY HH24:MI:SS.

10. Click OK and deselect Inactive. Click Save in the bottom half of the screen to 
save the parameter and then Save in the top half of the screen to save the task.

11. Repeat steps 3 to 10 for following tasks:

14. Execute one of the following execution plans. It must be same as you have 
executed in OCDA 2.1.

■ CDA - Complete Warehouse

■ CDA - Siebel Clinical Warehouse

■ CDA - Oracle Clinical Warehouse

15. Disable START_TS for each task:

a. Select CDA_Warehouse application in the ApplicationList.

b. Click Tasks tab in the top pane.

c. For each task in Table 3-1:

- Select the task.
- Click Parameters subtab in the bottom pane.
- Select Inactive for the START_TS parameter.

3.2.10 Merging Changes into a New Oracle-supplied Repository
Each OHSCDA release, and some patches, includes a copy of the OHSCDA 
Repository. If you do modify your copy of the OHSCDA Repository, you must merge 
your changes into the Oracle-supplied Repository each time you receive a release or 
patch of OHSCDA that includes a repository. At upgrade time, use the OBIEE Merge 
Repository Wizard (accessed through File > Merge) in the Repository Administration 
Tool to merge your modified RPD with the Oracle-supplied RPD.

For information on comparing and merging Repositories, refer to Oracle Fusion 
Middleware Metadata Repository Builder's Guide for Oracle Business Intelligence Enterprise 
Edition 11g Release 1.

Table 3–3  List of Tasks

Task Name

SDE_SC_Study_Site_Fact

SDE_OC_Study_Site_Fact

SDE_SC_Subject_Visit_Fact

Table 3–4  List of Tasks

Task Name

SDE_SC_Study_Site_Fact

SDE_OC_Study_Site_Fact

SDE_SC_Subject_Visit_Fact

SDE_SC_Study_Team_Dim

SDE_SC_Study_Region_Team_Dhls
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